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How to use this Competency Based Learning Material (CBLM) 

  

The module, Creating a Model Using CAD Software contains training materials and activities 

for you to complete. These activities may be completed as part of structured classroom 

activities or you may be required you to work at your own pace. These activities will ask you 

to complete associated learning and practice activities in order to gain knowledge and skills 

you need to achieve the learning outcomes.  

1. Review the Learning Activity page to understand the sequence of learning activities 

you will undergo. This page will serve as your road map towards the achievement of 

competence.  

  

2. Read the Information Sheets. This will give you an understanding of the jobs or tasks 

you are going to learn how to do. Once you have finished reading the Information 

Sheets complete the questions in the Self-Check.  

  

3. Self-Checks are found after each Information Sheet.  Self-Checks are designed to help 

you know how you are progressing.  If you are unable to answer the questions in the 

Self-Check you will need to re-read the relevant Information Sheet. Once you have 

completed all the questions check your answers by reading the relevant Answer Keys 

found at the end of this module.  

  

4. Next move on to the Job Sheets. Job Sheets provide detailed information about how 

to do the job you are being trained in. Some Job Sheets will also have a series of 

Activity Sheets. These sheets have been designed to introduce you to the job step by 

step. This is where you will apply the new knowledge you gained by reading the 

Information Sheets. This is your opportunity to practice the job. You may need to 

practice the job or activity several times before you become competent.  

   

5. Specification sheets, specifying the details of the job to be performed will be provided 

where appropriate.  

  

6. A review of competency is provided on the last page to help remind if all the required 

assessment criteria have been met. This record is for your own information and 

guidance and is not an official record of competency  

  

When working though this Module always be aware of your safety and the safety of others in 

the training room. Should you require assistance or clarification please consult your trainer or 

facilitator.  

  

When you have satisfactorily completed all the Jobs and/or Activities outlined in this 

module, an assessment event will be scheduled to assess if you have achieved competency 

in the specified learning outcomes. You will then be ready to move onto the next Unit of 

Competency or Module  
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Module Content 

Unit of Competency Create Model Using CAD Software 

Unit Code OU-LE-CNCCDM-04-L4-V1 

Module Title Creating Model Using CAD Software 

 

Module Descriptor 

This module covers the skills, knowledge and attitudes required to create model 

using CAD software. 

It specifically includes preparing for application of CAD software and creating 

CAD model. 

Nominal Hours 60 Hours 

 

Learning Outcome 

After completing the practice of the module, the trainees will be able to perform 

the following jobs: 

1. Prepare for application of CAD software 

2. Create CAD model 

 

Assessment Criteria 

1. Workpiece orientation of the 3D model is analyzed to produce a CAD model 

2. All general symbol, the standard of drawing is identified 

3. Tools and equipment are selected and collected as per job requirements 

4. Appropriate CAD software is installed as per the standard operating procedure 

5. System parameters are selected according to the job requirement 

6. Drawing interface is set required for 2D drawing 

7. Drafting tools are used for 2D drawing 

8. Smart dimension is used 

9. Feature tool is used 

10. Parts are assembled using assembly tools 

11. Created model is saved as per standard file format 

12. Model is printed as required 
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Learning Outcome -1: Prepare for Application of CAD Software 

 

 

 

 

Assessment Criteria 

1. Workpiece orientation of the 3D model is analyzed to produce a 

CAD model 

2. All general symbol, the standard of drawing is identified 

3. Tools and equipment are selected and collected as per job 

requirements 

4. Appropriate CAD software is installed as per the standard operating 

procedure 

5. System parameters are selected according to the job requirement 

 

 

 

 

 

Conditions and Resources 

1. Workplace or Simulated Workplace 

2. CBLM 

3. Handout 

4. Lap top 

5. Multimedia Projector 

6. Paper, Pen, Pencil, 

7. Internet Facilities 

8. White Board and 

9. Audio Video Devices 

10. Necessary tools and equipment 

11. Necessary PPE 

 

 

 

 

Contents 

1. CAD model 

2. 3D model 

3. Workpiece orientation 

▪ Top view 

▪ Front view 

▪ Right side view 

▪ Isometric view 

▪ Sectional view 

4. All common symbols 

5. drawing standards 
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 6. Tools and Equipment 

▪ Measuring tape 

▪ Vernier caliper 

▪ Vernier height gauge 

▪ Inside vernier micrometer 

▪ Outside vernier micrometer 

▪ Radius gauge 

▪ Filler gauge 

▪ Surface plate 

▪ Personal Computer/Laptop 

▪ Printer 

7. CAD software 

▪ Solid work or 

▪ Cutting or 

▪ Fusion 360 or 

▪ Siemens NX 

8. system parameters 

▪ Metrics 

▪ English 

9. Common software packages 

10. Computer hardware security 

11. Software maintenance and virus protection 

 

Job/Task/Activity 

1. Identify common symbols, drawing standards 

2. Select and collect tools and equipment according to job 

requirements 

3. Install CAD software according to standard operating procedures 

 

 

 

 

Training Method 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

9. Role Play 

Assessment Method 

1. Written Test 

2. Demonstration 

3. Oral questioning 
4. Portfolio 
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Learning Experience 1: Prepare For Application of CAD Software 
 

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

Learning Activities Recourses/Special Instructions 

1. Trainee will ask the instructor about the 

learning materials 

1. Instructor will provide the learning materials 

‘Create Model Using CAD Software 

2. Read the Information sheet and 

complete the Self Checks & 

Check answer sheets on “Create 

Model Using CAD Software 

2. Read Information sheet 1: Create Model Using 

CAD Software  

Answer Self-check 1: Create Model Using CAD 

Software Check your answer with Answer key 1: 

Create Model Using CAD Software 

3. Read the Job/Task Sheet and 

Specification Sheet and perform 

job/Task 

3. Job/Task Sheet and Specification Sheet  

Task Sheet 1-1: Identify common symbols, 

drawing standards 

Specification Sheet 1.1 Identify common 

symbols, drawing standards 

Task Sheet 1-2: Select and collect tools and 

equipment for CAD. 

Specification Sheet 1.2 Select and collect tools 

and equipment for CAD. 

Task  Sheet 1.3: Install CAD software according 

to standard operating procedures 

Specification Sheet 1.3 Install CAD software 

according to standard operating procedures 
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Information Sheet 1: Prepare for Application of CAD Software 

 

Learning Objective: After completion of this information sheet, the learners will be able to 

explain, define and interpret the following contents: 

1.1       CAD model 

1.2       3D model 

1.3       Workpiece orientation 

1.4       All common symbols 

1.5       drawing standards 

1.6       Tools and Equipment 

1.7       CAD software 

1.8       system parameters 

1.9       Common software packages 

1.10 Computer hardware security 

1.11 Software maintenance and virus protection 

 

1.1  CAD Model 

A CAD (Computer-Aided Design) model is a digital representation of a physical object or 

system created using computer software. CAD models are widely used in various 

industries, such as engineering, architecture, product design, and manufacturing. These 

models serve as virtual prototypes, allowing designers and engineers to visualize, analyze, 

and modify designs before they are physically produced. 

   

Commonly used CAD software includes AutoCAD, SolidWorks, CATIA, Siemens NX, 

and Fusion 360, among others. The choice of software depends on the specific 

requirements of the project and the industry in which it is being used. CAD models play a 

crucial role in modern design and engineering, helping to accelerate the product 

development lifecycle and improve the overall quality of designs. 

 

1.2  3D Model 

3D model is a digital representation of a three-dimensional object or scene created using 

computer graphics. These models are extensively used in various industries for 
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visualization, simulation, and design purposes. Unlike 2D models that only have width and 

height, 3D models add depth, providing a more realistic and immersive representation of 

objects. 

3D models have become integral to modern design and entertainment, providing powerful 

tools for creativity, analysis, and communication in diverse fields. 

1.3  Workpiece Orientation 

workpiece orientation refers to how a part or assembly is positioned in 3D space. It 

involves setting the appropriate orientation of the model to align it with the desired 

reference planes or axes. This is crucial for creating accurate designs and for 

manufacturing and assembly processes. 

 

a. Top view 

The "Top" view is one of the standard views that provides a clear and specific 

orientation of your 3D model. The "Top" view is aligned with the top plane of your 

model, making it useful for creating drawings, performing dimensioning, and 

visualizing the model from a consistent perspective. 

b. Front view 

Front view is another crucial standard view that depicts the model looking directly at 

its designated "front" face. This view is essential for understanding the overall shape, 

dimensions, and features on the front side of the object. 

c. Right side view 

The Right-Side view is a standard view that displays the model as if you are looking 

directly at it from the right side. This view is important for providing a clear 

understanding of the features, dimensions, and details located on the right side of the 

object. 
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d. Isometric view 

An isometric view is a specific type of view that displays the model in a three-

dimensional perspective. Isometric view isn't considered one of the standard views like 

front, top, or right. However, it's still a valuable way to visualize your model. It shows 

the object from a specific angle, where all three principal axes (X, Y, and Z) are equally 

spaced at 30 degrees from the viewing direction. 

 

e. Sectional view 

Section view is a special type of view that allows you to see the inner details of a model 

by virtually cutting through it along a user-defined plane or zone. This is especially 

useful for complex models with hidden internal features that wouldn't be visible in 

standard views. 

1.4  All Common Symbols 

Due to the vast number and diversity of symbols used across various CAD software and 

disciplines, providing a single, comprehensive list of all common symbols isn't feasible. 

However, here is a general approach to help you identify and understand common symbols 

you might encounter in CAD: 

a. Context and software: 

The type of CAD software and the specific context (e.g., mechanical, architectural, 

electrical) will heavily influence the symbols used. Different software applications 

might have their own symbol libraries or standards, while adhering to broader industry 

standards. 

b. Standard symbol libraries: 

Many industries and disciplines have established standard symbol libraries for 

commonly used elements. These libraries aim to ensure consistency and clarity in 

drawings across different projects and software. 

c. Software documentation and help resources: 

Most CAD software applications come with extensive documentation or built-in help 

resources that explain the functionality and meaning of the symbols used within the 

software. Consulting these resources is the most reliable way to accurately understand 

the symbols specific to your software and project context. 
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1.5  Drawing Standards 

      Drawing standards are essential in CAD software for various reasons: 

a. Consistency: They ensure consistent appearance, organization, and clarity across 

different drawings, facilitating communication and understanding for everyone 

involved. 

b. Accuracy: Using standardized approaches helps minimize errors and omissions in 

drawings, leading to a more accurate reflection of the design intent. 

c. Efficiency: Standardized practices and symbols save time and effort, 

streamlining the design and documentation process. 

d. Collaboration: Adherence to established standards promotes better collaboration 

by enabling stakeholders from different disciplines to interpret drawings accurately 

and efficiently. 

1.6  Tools and Equipment 

The tools and equipment you need to measure a part will depend on the size, shape, and 

features of the part, as well as the required level of precision. 

Describe Figure 

Measuring tape 

A measuring tape is a flexible ruler used to measure length 

or distance. It consists of a ribbon of cloth, plastic, 

fiberglass, or metal strip with linear measurement 

markings.  

Vernier caliper 

A vernier caliper is a precise measuring instrument used 

to measure the dimensions of objects, particularly their 

internal and external diameters, lengths, and depths. It 

combines a main scale with a vernier scale to achieve a 

higher level of accuracy than a standard ruler.  

Vernier height gauge 

vernier height gauge is a specialized measuring tool 

specifically designed to measure the height of objects with 

high precision. It builds upon the same principle of a 

vernier caliper, combining a main scale with a vernier 

scale to achieve accurate readings.  

Inside vernier micrometer 

inside vernier micrometer, also known as an internal 

micrometer, is a specialized measuring tool used to 

measure the internal diameter (ID) of objects with high 

precision. It functions similarly to a standard micrometer 

but is specifically designed to reach and measure the inner 

dimensions of holes, cylinders, and other cavities. 
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Outside vernier micrometer 

outside vernier micrometer, also known as a micrometer 

or mic, is a precision measuring instrument used to 

measure the external dimensions (OD) of objects, 

particularly their lengths, diameters, and thicknesses. It 

combines a screw mechanism with a vernier scale to 

achieve a significantly higher level of accuracy compared 

to a ruler or standard calipers. 

 

Radius gauge 

radius gauge, also known as a fillet gauge, is a specialized 

tool used to measure the radius of curved surfaces. By 

utilizing radius gauges effectively, you can achieve 

precise measurements of curved features, leading to 

improved accuracy and consistency in your projects.  

Filler gauge 

It's a thin, flat tool made of metal (often stainless steel) 

with various thicknesses etched or stamped on each leaf. 

you can achieve precise measurements of small gaps and 

clearances, leading to better results in various tasks and 

applications.  

Surface plate 

A surface plate is a solid, flat plate used as the main 

horizontal reference plane for various precision tasks in 

manufacturing, inspection, and other technical fields. It 

serves as a fundamental tool for ensuring accuracy and 

consistency in these processes.  

Personal computer/laptop 

A personal computer (PC), often referred to simply as a 

computer or a desktop, is an electronic device designed 

to perform various tasks and calculations based on user 

input and instructions. Laptops, on the other hand, are 

portable versions of personal computers offering similar 

functionalities but in a more compact and mobile form.  

Printer 

printer is a peripheral device that connects to a computer 

and produces physical copies (hard copies) of digital 

data. It's a crucial tool in various settings, allowing us to 

transform digital information into tangible documents, 

images, or other outputs.  

 

 



 

11 
 

1.7  CAD Software 

a. SolidWorks 

SolidWorks is a 3D computer-aided design (CAD) software developed by “Dassault 

Systems”. It is widely used in various industries for designing and modeling mechanical 

components, products, and systems. SolidWorks provides a robust set of tools for 

creating, simulating, and documenting 3D models, making it a popular choice among 

engineers, designers, and manufacturers. 

b. Fusion 360 

Fusion 360 is a cloud-based 3D computer-aided design (CAD), computer-aided 

engineering (CAE), and computer-aided manufacturing (CAM) platform developed by 

“Autodesk”. It is a comprehensive toolset that combines design, simulation, and 

manufacturing capabilities in a single integrated environment. Fusion 360 is 

particularly popular among engineers, designers, and makers for its collaborative 

features and its ability to support the entire product development process. 

c. Siemens NX 

Siemens NX is formerly known as Unigraphics or UG, is a comprehensive computer-

aided design, manufacturing, and engineering (CAD/CAM/CAE) software suite 

developed by “Siemens” Digital Industries Software. It is widely used in industries such 

as aerospace, automotive, electronics, and machinery for product design, engineering 

analysis, and manufacturing planning. Siemens NX is known for its advanced 

capabilities and integration across the product development lifecycle. 

1.8  System parameters 

In CAD (Computer-Aided Design) software refer to the settings, configurations, and 

specifications that define how the software operates on a computer system. These 

parameters can influence the performance, appearance, and functionality of the CAD 

software. 

a. Matric 

The choice of unit of measurement is crucial for accurate and consistent design. CAD 

software supports various metric and imperial units, allowing users to work with the 

system of measurement that is most relevant to their design specifications. 

b. English 

CAD software typically allows users to choose between different unit systems for 

creating and dimensioning designs. The two most common unit systems used in CAD 

software are the Metric system and the Imperial (English) system. Users can select their 

preferred unit system based on the project requirements and regional standards. 

1.9  Common Software Packages 

Here are some of the most common software packages used for Computer-Aided Design 

(CAD)  
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CAD Software’s Overview 

AutoCAD 

This is one of the oldest and most widely used CAD programs, 

developed by Autodesk. It offers a comprehensive set of 

features for 2D and 3D drafting, design, and documentation. 
 

SolidWorks 

This is a popular solid modeling software, also from Autodesk, 

used for creating 3D models of mechanical parts and 

assemblies. It is known for its user-friendly interface and 

powerful features for parametric design, simulation, and 

analysis.  

Catia V5 

This is a high-end CAD software from Dassault Systems, used 

in various industries like aerospace, automotive, and 

shipbuilding. It offers advanced features for complex surface 

modeling, assembly design, and engineering analysis. 
 

Inventor 

This is another solid modeling software from Autodesk, like 

SolidWorks, but geared more towards product design and 

manufacturing. It offers tools for creating parametric models, 

simulating product performance, and generating 

manufacturing documentation.  

Creo 

This is a suite of CAD software from PTC, offering various 

tools for product design, engineering, and manufacturing. It 

includes features for parametric modeling, simulation, and 

collaboration. 
 

NX 

This is a powerful CAD software from Siemens, used for 

complex product design and manufacturing in various 

industries. It offers advanced capabilities for modeling, 

simulation, and data management. 
 

Fusion 360 

This is a cloud-based CAD software from Autodesk, offering 

a combination of 2D and 3D design features. It's known for its 

user-friendly interface, collaborative capabilities, and 

accessibility across different devices. 
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SketchUp 

This is a popular 3D modeling software known for its ease of 

use and intuitive interface. While not specifically designed for 

engineering purposes, it's widely used for architectural 

modeling, interior design, and 3D printing.  

The choice of CAD software depends on various factors, including the specific needs of 

the user, industry, budget, and desired features. 

1.10  Computer Hardware Security 

While CAD software itself isn't inherently hardware-dependent in terms of security, 

the underlying computer hardware plays a vital role in protecting your CAD projects 

and intellectual property. 

CAD users can significantly reduce the risk of data breaches, unauthorized access, 

and other security threats, ensuring the protection of valuable design data and 

maintaining system integrity. 

1.11  Software Maintenance and Virus Protection 

Maintaining your CAD software and protecting it from viruses are crucial aspects of 

ensuring a smooth and secure workflow. Here's what you need to know: 

a. Software Maintenance: 

▪ Updates: Install software updates as soon as they become available. These 

updates often include bug fixes, security patches, and performance improvements. 

Enable automatic updates if available to avoid missing critical updates. 

▪ Licensing: Ensure your software license is valid and up-to-date. Outdated 

licenses can lead to limited functionality, potential security vulnerabilities, and 

difficulties accessing support. 

▪ Cleanup: Regularly clean up temporary files and unused software to free up disk 

space and improve performance. Use the built-in software uninstallers or reliable 

third-party tools to remove unnecessary software and avoid registry clutter. 

▪ Backups: Regularly back up your CAD files and system to a secure location (e.g., 

cloud storage, external drives) in case of software failures, hardware issues, or 

accidental data loss. 

b. Virus Protection: 

▪ Antivirus and anti-malware software: Install and maintain a reputable antivirus 

and anti-malware solution on your system. Keep the software updated with the 

latest virus definitions to ensure comprehensive protection against evolving 

threats. Configure real-time scanning to continuously monitor your system for 

malicious activity. 

▪ Firewalls: Enable a firewall on your system to filter incoming and outgoing 

network traffic, blocking unauthorized access and potential threats from entering 

your system. 
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Self-Check Sheet 1: Prepare for Application of CAD Software 
 

1. What is CAD? 

Answer:  

 

2. Why do we use CAD Software? 

Answer:  

 

3. Write some CAD Software? 

Answer:  

 

4. What are some key features of AutoCAD? 

Answer:  

 

5. What distinguishes SolidWorks from other CAD programs? 

Answer:  

 

6. What industries commonly utilize CATIA V5? 

Answer:  

 

7. How does Inventor differ from SolidWorks? 

Answer:  
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Answer Sheet 1: Prepare for Application of CAD Software 
 

1. What is CAD? 

Answer: Computer Added Design 

2. Why do we use CAD Software? 

Answer: For making visual Design to make any work easier. 

3. Write some CAD Software? 

Answer: AutoCAD, SolidWorks, NX, Fusion 360, Sketch Up etc. 

4. What are some key features of AutoCAD? 

Answer: Some key features of AutoCAD include: 

▪ 2D drafting and drawing tools 

▪ 3D modeling capabilities 

▪ Annotation and documentation features 

▪ Collaboration tools for sharing designs 

▪ Customization options through APIs and scripting 

▪ Compatibility with various file formats 

 

5. What distinguishes SolidWorks from other CAD programs? 

Answer: What distinguishes SolidWorks from other CAD programs is its focus on solid 

modeling specifically tailored for mechanical design. SolidWorks offers powerful 

features for parametric design, simulation, and analysis, along with an intuitive user 

interface that makes it accessible to engineers and designers. 

6. What industries commonly utilize CATIA V5? 

Answer: CATIA V5 is commonly utilized in industries such as aerospace, automotive, 

defense, and shipbuilding. Its advanced features for complex surface modeling, 

assembly design, and engineering analysis make it particularly well-suited for these 

industries where precision and high-performance design are crucial. 

7. How does Inventor differ from SolidWorks? 

Answer: Inventor differs from SolidWorks in its emphasis on product design and 

manufacturing. While both offer parametric modeling and simulation tools, Inventor is 

often preferred by manufacturers for its integrated tools for creating manufacturing 

documentation, simulating product performance, and managing data throughout the 

design process.  
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Activities Sheet 1.1: Identify Common Symbols, Drawing Standards 

 

▪ Wear appropriate PPE for the job 

▪ Read the Job sheet and Specification sheet provided 

▪ Collect paper  

▪ Identify common symbols, drawing standards  

▪ List common symbols  

▪ Write Symbol description  

▪ Clean workplace. 

 

Sl No Symbol No Description 

1.  1. (A) 
Symbol is placed on a dimension line directly in line with the dimension 

arrows.  

2.  2. (B) Symbol placed on the leader arrow of a size dimension.  

3.  3. (C) Symbol placed on a non-planar feature of size. 

4.  4. (D) Placed off a feature control frame that is applied to a feature of size 

5.  5. (E) Symbol placed on the arrows of a size dimension.  

6.  6. (F) 
Placed as one half in an open-ended size dimension (in line with the 

arrow). 
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Specification Sheet 1.1: Identify Common Symbols, Drawing 

Standards 

. 
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Activities Sheet 1.2: Select and Collect Tools and Equipment for CAD 

 

1. Wear appropriate PPE for the job 

2. Read the Job sheet and Specification sheet provided 

3. Select tools and equipment for CAD  

4. collect tools and equipment for CAD  

5. Clean workplace. 
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Specification Sheet 1.2: Select and Collect Tools and Equipment for 

CAD 

 

 

 

Required equipment for CAD 

Sl No Name of equipment’s Specification Quantity 

1 Computer 

Core i5-i7 

Ram 8Gb 

SSD 512 

01 
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Activities Sheet 1.3: Install CAD Software (Solid Works) According to 

Standard Operating Procedures 

 

Procedure: 

1. Download Software from the SolidWorks website if you have a valid license or 

subscription. 

2. Run the SolidWorks installer by double-clicking on the setup file. 

3. Choose the appropriate option based on your requirements. For a single installation, select 

"Individual (on this computer)." 

4. Read through the license agreement presented by the installer and accept it to proceed 

with the installation. 

    

1 2 3 4 

5. Choose the products and modules you want to install. You can select options such as 

SolidWorks Standard, SolidWorks Professional, SolidWorks Premium, add-ins, and 

additional tools. 

6. Choose Installation Location specify the directory where to install SolidWorks.  

7. Select Toolbox/Hardware Libraries Location to install these libraries locally or on a 

network location. 

8. Enter the serial number provided to you by SolidWorks. 

    

5 6 7 8 

  

9. Configuring all the options, start the installation process.  

10. Restart computer when installation is complete 

11. Perform restarting your computer, launch SolidWorks.  

12. Update SolidWorks the latest service packs or patches to ensure that your SolidWorks 

installation is up to date and stable.  

 

  



 

21 
 

Specification Sheet 1.3: Install CAD Software According to Standard 

Operating Procedures 
 

 

 

Required equipment  

Sl No 
Name of 

equipment’s 
Specification Quantity 

1 Computer Core i5-i7, Ram 8Gb, SSD 512 01 

2 CAD software SolidWorks 21 01 
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Learning Outcome 2: Create CAD Model 
 

 

 

 

Assessment Criteria 

1. Drawing interface is set required for 2D drawing 

2. Drafting tools are used for 2D drawing 

3. Smart dimension is used 

4. Feature tool is used 

5. Parts are assembled using assembly tools 

6. Created model is saved as per standard file format 

7. Model is printed as required 

 

 

 

 

 

 

Conditions and Resources 

1. Workplace or Simulated Workplace 

2. CBLM 

3. Handout 

4. Laptop/Computer 

5. Multimedia Projector 

6. Paper, Pen, Pencil, 

7. Internet Facilities 

8. White Board and 

9. Audio Video Devices 

10. Necessary Tools and Equipment & Materials 

11. Necessary PPE 

 

 

 

 

 

 

 

 

 

 

 

 

Contents 

1. 2D drawing 

2. Drawing interface 

▪ Menu 

▪ Toolbar 

3. Drafting 

tools 

▪ 2D sketch 

➢ Points 

➢ Line 

➢ Circle 

➢ Arcs 

➢ Rectangle 

➢ Splines 

➢ Ellipse 

➢ Polygon 

➢ Slot 

➢ Chamfer and fillet 

▪ Edit and modify 

➢ Trim 

➢ Extend 

➢ Mirror 

➢ Offset 

➢ Copy 

➢ Mov 

➢ Delete 
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 4. Scaling 

5. Relation 

▪ Parallel 

▪ Horizontal 

▪ Vertical 

▪ Coincide 

▪ Collinear 

▪ Tangent 

▪ Fix 

6. Modeling tools 

7. Pattern tool 

8. Smart Dimension 

9. Feature Tool 

▪ Extruded boss 

▪ Extrude cut 

▪ Draft 

▪ Revolve boss and cut 

▪ Lofted boss and cut 

▪ Swept boss and cut 

▪ Boundary bosses and cuts 

▪ Pattern 

▪ Linear pattern 

▪ Circular pattern 

▪ Shell and Rib 

▪ Mirror 

▪ Hole Wizard 

▪ Rap 

10. Assembly tool 

▪ Edit component 

▪ Insert component 

▪ Met 

▪ Component Preview window 

▪ Linear component pattern 

▪ Smart fasteners 

▪ Move component 

11. Standard file format 

12. Drawing interpretation 

▪ Standard drawing scales, symbols, and abbreviations 

▪ Orthographic projection (1st and 3rd angle) 

▪ Perspective 

▪ Section view 

▪ Dimensioning 

▪ Measurement tolerance 

▪ Surface condition (surface finish/texture) 

▪ Limit and fit 
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▪ Clearance 

 

 

Job/Task/Activity 

1. Set the drawing interface for 2D drawing 

2. Use smart dimensions 

3. Use the Features tool 

4. Assemble the parts using the assembly tool 

Perform  model printing 

 

 

 

Training Method 

1. Discussion 

2. Presentation 

3. Demonstration 

4. Guided Practice 

5. Individual Practice 

6. Project Work 

7. Problem Solving 

8. Brainstorming 

 

Assessment Method 

1. Written Test 

2. Demonstration 

3. Oral questioning 
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Learning Experience 2: Create CAD Model 
 

In order to achieve the objectives stated in this learning guide, you must perform the 

learning steps below. Beside each step are the resources or special instructions you will 

use to accomplish the corresponding activity. 

Learning Activities Recourses/Special Instructions 

1. Trainee will ask the instructor about 

the learning materials 

1. Instructor will provide the learning materials 

‘Create Model Using CAD Software 

2. Read the Information sheet and 

complete the Self Checks & 

Check answer sheets on 

“Create Model Using CAD 

Software 

2. Read Information sheet 2: Create CAD model 

Self-check 2: Create CAD model 

Check your answer with Answer key 2: Create CAD 

model 

 

3. Read the Job/Task Sheet and 

Specification Sheet and 

perform job/Task 

3. Job/Task Sheet and Specification Sheet  

Task  Sheet 2.1: Set the drawing interface for 2D 

drawing 

Specification Sheet 2.1 Set the drawing interface for 2D 

drawing 

 

Job Sheet 2-2: Use smart dimensions 

Specification Sheet 2.2 Use smart dimensions 

 

Job  Sheet 2-3: Use the Features tool 

Specification Sheet 2.3 Use the Features tool 

 

Job Sheet 2.4: Assemble the parts using the assembly 

tool 

Specification Sheet 2.4 Assemble the parts using the 

assembly tool 

 

Job  Sheet 2.5: Perform  model printing 

Specification Sheet 2.5 Perform model printing 
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Information Sheet 2: Create CAD Model 

Learning Objective: After completion of this information sheet, the learners will be able to 

explain, define and interpret the following contents 

2.1   2D drawing 

2.2   Drawing interface 

2.3    Drafting tools 

2.4   Smart Dimension 

2.5   Feature Tool 

2.6   Assembly tool 

2.7   Standard file format 

2.8   Drawing interpretation 

 

2.1 2D Drawing 

2D drawing, also known as two-dimensional drawing, refers to a representation of a three-

dimensional object on a flat surface. It captures the width and height of the object, but not 

its depth. 2D drawings play a crucial role in various fields, including: 

▪ Engineering and design: Used to create blueprints, schematics, and technical drawings 

for buildings, machines, products, and infrastructure projects. 

▪ Architecture: Employed to create floor plans, elevations, sections, and other 

architectural drawings to represent buildings. 

▪ Art and animation: Used for creating illustrations, sketches, storyboards, and animation 

frames. 

▪ Technical communication: Employed in manuals, instructions, and guides to illustrate 

procedures, processes, and assembly instructions. 

 

2.2 Drawing Interface 

In the case of CAD design, we are going to use SolidWorks 2022 CAD software. Nowadays, 

it is widely used for Mechanical Design and CAM software also. 

SolidWorks User interface: While starting SolidWorks for the first time, the SolidWorks 

screen with Welcome – SolidWorks 2022 dialog box by default get displayed, as shown. 
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Quick Access Toolbar (Manu): the Quick Access Toolbar is located at the top of the 

SolidWorks or above Command Manager. It provides quick access to some commonly used 

tools such as Home, New, Open, Save, Print, Undo, Select, Rebuild, and so on, as shown. 

 
New: The New tool is used to display New SOLIDWORKS Document dialog box with 

Part, Assembly, and Drawing buttons used to enter their respective environments of 

SolidWorks. 

 
Next double-click on the Part button to enter in the Part Environment, as shown. 

 
Menu 

Menu Bar: Move the cursor over SolidWorks logo’s arrow icon at top left corner of the 

SolidWorks window, as shown. Next, click on the ‘pin’ icon to pin the menu bar, as 

shown. 

 

Toolbar 

▪ View (Heads-Up) Toolbar: This toolbar is located at the top of the drawing/graphic 

area. In this toolbar, the tools used to modify display are grouped in it, shown. 
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▪ Command Manager: Command Manager is located at the top of the window and 

below the Menu Bar, as shown. It contains tools organized in the set of various 

Command Manager tabs. On each tab, the related tools/buttons are grouped. When you 

click on a tab, various groups appear. These groups have different tools, as shown. 

 
▪ Features Command Manager: This Command Manager tab has various solid 

modelling tools used to convert sketches in solid models. 

 
▪ Sketch Command Manager: This Command Manager has various sketching tools, used 

for drawing 2D and 3D sketches. 

 
▪ Assembly Command Manager: This Command Manager contains the tools used to 

insert the previously created components and assemble them by applying various mates. 

 
▪ Feature Manager Design Tree: The Feature 

Manager Design Tree is a type of Navigator 

window that stores and display all the 

features/operations in a sequence that you have 

done while working in any file. It also contains 

details of planes, materials, appearances, lights 

and other features, added to the model. By 

default, it displays on the left side of different 

environments in SolidWorks (in part model, 

assembly, drawing, and so on). To edit/modify 

any feature, you can select the respective option 

from the shortcut menu display after right-

clicking over any respective feature, as shown. 

 

▪ All in one: all basic commands in one page. 
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Some shortcut keys of SolidWorks 2022. 

  

2.3 Drafting Tools 

Drafting tools are the building blocks of creating precise and technical drawings in CAD 

software. They allow you to construct everything from basic shapes to complex geometries, 

and are essential for any CAD user. 

a. 2D sketch 

Select the ‘New’ button from the menu bar to display the New SOLIDWORKS Document 

dialog box. Next click on the Part button of the dialog box, if it is not selected by default. 

Now click on the OK button; the part environment will be displayed, as shown before. 

Note that you need to click on the Sketch tab to enter in the Sketching Environment, if any 

other tab is selected by default, as we seen before. 

 

b. Sketching directly in the Part environment: Creating sketches in SolidWorks Part 

environment is very easy. You have to activate the Sketch tool first and then define a plane 

on which you want to create the sketch. To do this, click on the Sketch button from the 

Sketch Command Manager, the planes get displayed. Now you must select any of the 

required plane in which you want to draw the sketch, as shown. 
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Points 

This tool is used to place sketched point in the drawing area or on any sketch entity while 

drawing a sketch. 

Click on Point tool from the Sketch Command Manager to activate it > Click anywhere in the 

drawing area to place Point and display the Point Property Manager, as shown. > Also, the 

coordinates of point at current location get displayed in the X Coordinate and Y Coordinate 

spinners, as shown. You can enter the required coordinates in these spinners to change it 

location. > Now click on the Click Dialog button from the Property Manager to close it and 

display the point placed, as shown. 

  

Line 

This tool is used to draw a line while creating sketches. The steps to draw a line using this 

tool are. Click on the Line logo button from the Sketch Command Manager to activate the 

Line tool, as shown above. Alternatively, you can activate the Line tool by pressing the “L” 

key from the keyboard. > The Insert Line Property Manager will get displayed, as shown. > 

Click in the drawing area to define the start and endpoints of the line, as shown. > Press the 

Esc key from the keyboard to deactivate the Line tool. 
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If you draw a horizontal and vertical line, the respective symbol of the line gets displayed 

with it, as shown. 

 
The As sketched radio button is selected by default which helps you in drawing the line in 

any direction, until you release the pointer. 

 
▪ Horizontal: This radio button is selected to draw the line horizontally. 

▪ Vertical: This radio button is selected to draw the line vertically 

 

▪ Angle: This radio button is selected to draw the line at an angle, relatively with 

the horizontal line. 
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▪ For construction: This radio button is selected to draw a construction line, as 

shown. 

 

▪ Infinite length: This radio button is selected to draw a line with infinite length, as 

shown. 

 

▪ Midpoint line: This radio button is selected to draw a line, symmetrical from the 

midpoint of the line. 

 

▪ TIP: If you select Horizontal, Vertical or Angle radio button; the Parameters 

rollout with Length and Angle edit box will get displayed in the Insert Line 

PropertyManager, as shown. These edit boxes can be used to draw a line with 

required length, angle or both. 
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▪ Toggle between Line and Arc Tools: After drawing the line entity, you can switch 

between the Line and Arc tools, which helps you in drawing normal or tangent arc 

to the previous line. To switch between Line and Arc tool, after drawing lines right-

click to highlight the shortcut menu and select “Switch to arc (A) “option from it; 

the Line tool get changed to Arc tool. Alternatively, you can toggle between the Arc 

and Line tool by pressing the “A” key. > Move the cursor towards left to define the 

second point of the arc, as shown. 

 

Circle 

This is the most common and easiest way to draw a circle. 

Select Circle > Circle option from the Sketch Command Manager to activate it and display 

the Circle Property Manager. Alternately, you can click on the Circle tool directly, if it is 

selected by default. > Click to define the center point of the circle. > Move the cursor upto 

some distance and click to define the radius of the circle. > Press the Esc key from the 

keyboard to deactivate the Circle tool. 

 

Perimeter Circle Tool: This tool is used to create a circle by using three points. 

Click Circle > Perimeter Circle from the Sketch Command Manager, as shown above. You 

can also toggle between Circle and Perimeter Circle tool from the Circle Type rollout of 

the Circle Property Manager, as shown above. > Click and define three points in the 

drawing area, as shown. The first two points define the location of the circle and the third 

point defines its radius. > After drawing circle using tools in the Circle flyout, the Circle 

Property Manager get replaced with new Circle Property Manager, as shown. 



 

      Page | 34  
 
 

 
The options in the Parameters rollout in the Circle Property Manager helps in modifying 

radius and coordinates of the center point of the circle. You can also draw a construction 

circle by selecting the For construction check box in the Options rollout, after drawing a 

circle. The circle will get converted into construction circle. 

 

Arcs 

This tool is the used to draw an arc during drawing a sketch. There are three different 

tools available in the Arc flyout to create three different types of arcs. 

Center point Arc: Select Arc > Center point Arc from the Sketch Command Manager to 

activate it and display the Arc Property Manager, as shown. Alternately, you can click on 

the Center point Arc tool directly, if it is selected by default. > Click in the drawing area to 

define center point (1) for the arc, as shown. > Move the cursor up to some distance towards 

left and click to define start point (2) of the arc. > Move the cursor upwards and click to 

define third or end point (3) of the arc. > Press the Esc key from the keyboard to exit the 

tool and display arc created. 

 
Tangent Arc Tool: This tool is used to draw arc tangent to an existing entity. 
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Select Arc > Tangent Arc from the Sketch Command Manager to activate it. Alternatively, 

you can also select Tangent Arc tool from the Arc Type rollout of the Arc Property Manager, 

as shown above. > Click on the end point of the left line entity to define start point (1) of 

the arc, as shown > Move the cursor slightly right and click on the end point of right line 

entity to define end point (2) of Arc, as shown. > Press the Esc key twice from the keyboard 

to exit the tool and display arc created, as shown. 

 

3 Point Arc: This tool is used to create an arc by defining its two endpoints, and a radius. 

Select Arc > 3 Point Arc from the Sketch Command Manager to activate it. > Click in the 

drawing area to define start point (1) and end point (2) of the arc, as shown. > Move the 

cursor up to some distance and click to define third or end point (3) of the arc, as shown. 

The third point defines radius of arc, as shown. > Press the Esc key to exit the tool and 

display arc created, as shown. 

 

Rectangle 

The Rectangle tool is used to create rectangle which is the combination of four lines. There 

are five different tools available in the Rectangle flyout to create five types of rectangles, 

Corner Rectangle, CenterPoint rectangle, 3 Point Corner Rectangle, Parallelogram, 3 Point 

Center Rectangle. 

▪ Corner Rectangle tool: Click on the Corner Rectangle tool from the Rectangle 

flyout to display Rectangle Property Manager, as shown. > Click in the drawing area 

to define the first corner of the rectangle, as shown. > Drag the cursor diagonally 

and click to define the second corner of the rectangle, as shown. > The X & Y 

measures the length and width of the rectangle. 
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▪ 3 Point Corner Rectangle: This tool is used to create a rectangle at a selected angle, 

by defining three points: center of the rectangle and its corner. Click on the 3 Point 

Corner Rectangle tool from the Rectangle flyout. > Click anywhere in the drawing 

area to define point 1 as the start point of the rectangle, as shown. > Move the cursor 

and click to define point 2 as the endpoint of the base line, as shown. > Again, move 

the cursor and click to define point 3 as the width of the rectangle, as shown. 

 
▪ 3 Point Center Rectangle: This tool is used to create a rectangle with center point 

at an angle. Click on the 3 Point Center Rectangle tool from the Rectangle flyout. > 

Click anywhere in the drawing area to define point 1 as the center point of the 

rectangle, as shown. > Move the cursor and click to define point 2 at the distance 

half to the length of rectangle, as shown. > Again, move the cursor and click to define 

point 3 as the width of the rectangle, as shown. 

 
▪ Parallelogram: This command creates a parallelogram by using three points that 

you specify. Choose the Parallelogram tool from the Rectangle flyout. > Click in the 

drawing area and define start and end point of the length of the base line of the 

parallelogram, as shown. > Move the cursor and click anywhere to define the 

height/width of the parallelogram, as shown. 
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Splines 

This tool is used to create a smooth spline curve passing through the defined points by clicking 

in the drawing area. There are four different tools available in the Spline flyout to create 

splines in four different types, style spline, spline on surface, equation driven curve. 

Select the Spline tool (select Sketch > Spline). > Click to define start points for the spline in 

the graphics window. > Similarly, click to define the other points for creating spline, as shown. 

 

Ellipse 

This tool is used to draw an ellipse by defining center point and end points for major and 

minor axis. Click on the Ellipse tool from the Sketch Command Manager to activate it. > 

Click in the drawing area to define point (1) as the center point of ellipse, as shown. > Move 

the cursor horizontally and click to define point (2) as the radius along major axis, as shown. 

> Now, move the cursor vertically and click to define point (3) as the radius along minor axis, 

as shown. 

 

▪ Partial Ellipse Tool: This tool is used to create a partial ellipse in the sketch 

environment. Select Ellipse > Partial Ellipse tool from the Sketch Command Manager, 

as shown above.  Move the cursor horizontally and click to define point (1) as the center 

of ellipse, as shown.  Move the cursor vertically and click to define point (2) for the 

radius along major axis, as shown.  Next, click to define point (3) for the radius along 

minor axis and start point of ellipse, as shown. 
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Now click to define point (4) as the end point of the ellipse and display the preview of partial 

ellipse, as shown.  Next, you can enter the required values in the respective edit boxes 

available under Parameters rollout of Ellipse Property Manager if required, as shown.  

Click on the button from the Property Manager to exit it and display the ellipse, as shown. 

 
Polygon 

This tool is used to create a polygon. A polygon is a single object having multiple sides and 

all sides equilateral and equiangular with each other. In SolidWorks, you can draw a 

polygon with 3 to 40 sides. The polygon is displayed inside or outside the construction 

circle. 

Click on Polygon tool from the Sketch Command Manager to activate it and display the 

Polygon Property Manager, as shown. > Enter the required number of sides of polygon in 

the Number of sides edit box under Parameter rollout, as shown. > Select the Inscribed 

circle radio button if it is not selected, as shown. > Click in the drawing area to define the 

point (1) as center point of the construction circle of polygon, as shown. > Move the cursor 

upto some distance and click to define point (2) for radius of construction circle of polygon, 

as shown. > Now click on the Close Dialog button from the Property Manager to display 

the polygon with construction circle inside it, as shown. 
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Similarly, by selecting the Circumscribed circle radio button from the Polygon Property 

Manager, you can create a polygon with construction circle outside it. 

c. Slot 

These tools are used to create slots. There are four different types of tools in the Slot flyout to 

create slots, Straight Slot Tool, CenterPoint Straight Slot Tool, 3 Point Arc Slot Tool, 

CenterPoint Arc Slot Tool. 

▪ straight slot: To create a straight slot by defining three points – first end/start point, 

second end point, and third point that defines its width. Click on Slot > Straight Slot tool 

from the Sketch Command Manager to activate it, as shown above. > Click in the 

drawing area to define the point (1) as first end/start point of the straight slot, as shown. 

> Move the cursor up to some distance and click to define point (2) as second end point 

of the slot to display the preview of slot, as shown. > Again, move the cursor up to some 

distance and click to define point (3) for width of Straight Slot, as shown. > After Straight 

Slot get displayed, the Slot Property Manager with active edit boxes under Parameters 

rollout get displayed, as shown. > Next, you can modify the slot by entering required 

values in their respective edit boxes if required, as shown. > Now click on the button 

from the Slot Property Manager to exit it and click in the drawing area to display the 

straight slot, as shown. Alternatively, you can select the ESC key from keyboard. 

 
d. Chamfer and fillet 

The fillet: This tool is used to create a fillet or round a sharp corner created by intersection 

of two lines, arcs, circles, and rectangle or polygon vertices. The Fillet Tool This tool is 

used to create a fillet or round a sharp corner created by intersection of two lines, arcs, 

circles, and rectangle or polygon vertices. Click on the Sketch Fillet tool from the Sketch 

Command Manager to activate it and display the Sketch Fillet Property Manager, as shown. 
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> Click on the entities (two lines, two arcs, or a line and an arcs) to create fillet between 

them, as shown > The preview of fillets tangent to selected entities get visible with default 

radius value in the Sketch Fillet Property Manager, as shown. > Next, you can enter or 

adjust the required radius value in the Fillet Radius spinner of the Property Manager if 

required. > Click on the OK button from the Sketch Fillet Property Manager to display the 

fillets created, as shown. 

 
The entities are automatically trimmed or extended to meet the end of the new fillet radius. 

> The tool is still active and you can again enter required radius values and select other 

entities to create fillets, as shown. 

 
Sketch Chamfer: This tool is used to create a chamfer between two selected entities by 

applying - two distance values, same distance value or distance and angle values. There are 

two radio buttons available in the Sketch Chamfer Property Manager, used to create these 

three types of chamfers, disused next. 

 

Angle-distance: This radio button is selected to create chamfer between two selected entities 

by using distance and angle values. Select Sketch Fillet > Sketch Chamfer option from the 

Sketch Command Manager to activate it and display the Sketch Chamfer Property Manager, 

as shown. > Select the Angle-distance radio button from the Sketch Chamfer Property 

Manager, as shown. > Enter or set the required distance and angle values in the Distance 1 

and Direction 1 Angle spinners, as shown. > Now, select the entities one by one to create 

chamfers between them, as shown. Note that the angle will be measured with respect to the 

first selected entity and distance with respect to the second selected entity. > The entities are 

automatically trimmed or extended to meet the end of the new chamfer, as shown. > Now, 

click on the OK button from the Sketch Chamfer Property Manager to exit from this tool. 
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Distance-distance: This radio button is used to create chamfer between two selected entities 

by using same distance value or different distance values. 

Select the Sketch Chamfer option to activate it and display the Sketch Chamfer Property 

Manager, as discussed above. > Now select the Distance-distance radio button, if it is not 

selected by default, as shown. > Next enter the required distance value in the Distance 1 

spinner of the Property Manager, as shown. > Select the entities to create chamfer between 

them, as shown. 

 
The chamfer between selected entities with equal distance in both directions get visible, as 

shown. > The entities are automatically trimmed or extended to meet the end of the new 

chamfer, as shown. 

 
e. Edit and modify 

Editing and modifying in CAD involves making changes to an existing digital model or 

drawing. This can be done through a variety of tools and techniques, depending on the specific 

requirement and the type of modifications you want to make. 

f. Trim 

This tool is used to trim/remove the unwanted portion of entities, intersecting other entities 

like line, circle, arc, ellipse, circle etc. The options/buttons available in the Options rollout of 

the Trim Property Manager are discussed below. 
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Power Trim: This button is selected to trim/remove the unwanted portion of entities by 

dragging cursor over it. 

Select the Trim Entities tool from the Sketch Command Manager to activate it and display the 

Trim Property Manager, as shown. > Select the Power trim button if it is not selected by 

default, as shown. > Click in the drawing area and drag the cursor over the entities to be 

removed, by press and holding the LMB (Left Mouse Button). > Release the finger over LMB 

to display the sketch with removed entities. > Now, click on the Close Dialog logo button 

from the Trim Property Manager to exit from the tool. 

 
Corner, Trim Away Inside, Trim Away Outside, Trim to closest. Those are the option of 

other trim function. 

g. Extend 

This tool is used to extend a sketch entity up to the next sketch entity. Select Trim Entities > 

Extend Entities tool from the Sketch Command Manager to activate it, as shown. > Select the 

sketch entities to extend, as shown. > The selected entities get extended to the next entities, 

as shown. 

 

h. Mirror 

The Mirror Entities tool is used to create a mirror copy of selected sketch entity about a 

centerline, lines, model edges and linear edges on drawing. This is very useful for creating 

symmetrical sketches. Click on the Mirror Entities tool from the Sketch Command Manager 

to activate it and display the Mirror Property Manager, as shown. > Select the sketch entities 

to mirror, as shown. > Now click on the Mirror about in the Property Manager. > Select the 

horizontal centerline to display the mirrored entities along it, as shown. > Click on the OK 

button from the Property Manager to exit the tool and display the mirrored entities, as shown. 
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i. Offset 

The Offset Entities tool is used to create a duplicate geometry at a required offset distance 

from the selected geometry. You can offset sketch entities like lines, arcs, circles, set of 

model edges, loops etc. If you change the original entity then the offset entity changes 

accordingly. 

Click on the Offset Entities tool from the Sketch Command Manager to activate it and 

display the Offset Entities Property Manager, as shown. The use of options in the 

Parameters rollout of the Property Manager are discussed below. 

 
The Add dimensions check box is selected to display the offset distance in sketch after 

offsetting any sketch entity/entities. 

The Offset Distance check box is selected to change direction of offset. 

This ‘select chain’ check box is selected by default and is used to select chain of entities and 

entities connected with the selected entity. 

 

j. Copy 

The Copy Entities tool is used to copy objects and place them at a required location. This 

tool is like the Move tool, except that object will remain at its original position and a copy 

of it will be placed at the new location. 
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Draw a rectangle and two concentric circles inside it, as shown. > Select Move Entities > 

Copy Entities from the Sketch Command Manager to activate it and display the Copy Property 

Manager, as shown below. > Select the circle entities, and then right-click to accept the 

selection, as shown. > Click on the center of the circles to select it as the base point. > Move 

the cursor up to some distance towards right to place the copied entities. > Next click to place 

the copied entities at the required location. 

 

k. Move 

The Move tool is used to move a selected object(s) from one location to a new location 

without changing its orientation. To move objects, you need to select this tool and select 

the objects Move Entities from the drawing area. After selecting objects, you need to 

specify the ‘base point’ and the ‘destination point’. 

Click on the Move Entities button from the Sketch Command Manager to activate it and 

display the Move Property Manager, as shown below. > Select the circle entity to move 

and click on the Start point box of the Property Manager. Alternatively, you can press the 

RMB (Right Mouse Button) after selecting the entity to move. > Next, click on the center 

of the circle to select it as the base point, as shown. > Move the cursor up to some distance 

toward right, as shown. > Next click to place the moved circle entity, as shown. 

 

 

l. Scaling 

The Scale Entities tool is used to change the size of objects. You can reduce or enlarge the 

size without changing the shape of an object. To scale objects, you need to activate this 

tool and select the objects from the drawing window. After selecting objects, you need to 
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specify the ‘base point’ and the scale factor. The scale factor is the ratio between the 

original size of the object and the size to be achieved. For example, if you specify the 

Scale Factor as 2, the size of the object will be doubled. 

Select Move Entities > Scale Entities from the Sketch Command Manager to activate it 

and display the Scale Property Manager, as shown below. > Select all sketch entities and 

then right-click to accept the selection, as shown below. > Click on the endpoint of the 

bottom line on left to select it as the base point, as shown. > Next, using the spinner specify 

the required Scale Factor, as shown. Alternatively, enter the required Scale Factor value in 

the edit box of the Property Manager, as shown. As you change the Scale Factor value, the 

size of object changes accordingly, as shown. > Next, click on the OK button of the 

Property Manager to exit the tool and display the entities rotated, as shown. 

 

m. Relation 

Parallel 

This relation is used to make two lines parallel to each other. 

Select the Add Relation option to activate it and display the Add Relations Property 

Manager. > Select the entities one by one, as shown. > Next click on the Parallel button 

from the Property Manager to apply parallel relation. > Next, click on the OK button of 

the Property Manager to exit it and display entities with parallel relation and symbol, as 

shown. 

 
 

Horizontal 

This relation is used to make entities horizontal or apply horizontal relation among 

selected entities. 

Select the Add Relation option (Sketch > Display/Delete Relations > Add Relation) to 

activate it and display the Add Relations Property Manager, as shown above. > Select the 

line entity/entities, as shown. > Next click on the Horizontal button from the Property 

Manager to apply and display entities with Horizontal relation, as shown. > Click on the 

OK button of the Property Manager to exit it and click to display entities with horizontal 

relations, as shown. You can also select an external entity such as an edge, plane, axis, or 

sketch curve on an external sketch that will act as a line to apply this relation. 
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Vertical 

This relation is used to make entities vertical or apply vertical relation among selected 

entities. 

Select the Add Relation option to activate it and display the Add Relations Property 

Manager, as shown above. > Select the line entity/entities, as shown. > Next click on the 

Vertical button from the Property Manager to apply and display entities with vertical 

relation, as shown. > Click on the OK button of the Property Manager to exit it and click 

to display entities with vertical relations, as shown. 

 

Coincident 

This relation is used to make a line entity coincident to selected point entity. 

Select the Add Relation option to activate it and display the Add Relations Property 

Manager. > Select the end point of the line entity and then select another line entity, as 

shown. > Next click on the Coincident button from the Property Manager to apply 

coincident relation. > Click on the OK button of the Property Manager to exit it and 

display entities with coincident relation and symbol, as shown. Similarly, you can apply 

coincident relation between arc, circle, and ellipse with the selected point, as shown. 

 

Collinear 

This relation is used to make the selected line to lie on the same straight/infinite line. 

Select the Add Relation option to activate it and display the Add Relations Property 

Manager. > Select the entities one by one, as shown. > Next click on the Collinear button 

from the Property Manager to apply collinear relation. > Click on the OK button of the 

Property Manager to exit it and display entities with collinear relation and symbol, as 

shown. 
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Tangent 

This relation is used to make an arc, circle, or line entity tangent to each other. 

Select the Add Relation option to activate it and display the Add Relations Property 

Manager. > Select the entities one by one, as shown. > Next click on the Tangent button 

from the Property Manager to apply tangent relation. > Click on the OK button of the 

Property Manager to exit it and display entities with tangent relation and symbol, as 

shown. 

 

n. Fix 

This relation is used to fix the position of the selected entity. 

Select the Add Relation option to activate it and display the Add Relations Property 

Manager. > Click on the line entity, as shown. > Next click on the Fix button from the 

Property Manager to apply fix relation. > Click on the OK button of the Property Manager 

to exit it and display entities with fix relation and symbol, as shown. If you apply fix 

relation to line or arc entities, you can change their sizes by dragging their endpoints, as 

shown. 

 

o. Modeling tools 

SolidWorks offers a vast array of modeling tools for creating complex and intricate 3D 

models. These tools cater to various design needs, from basic extrusions to advanced 

sculpting techniques. 

 

p. Pattern tool 

In SolidWorks, there are various Pattern tools, used to create replica of a feature using 

different options - Linear Pattern, Circular Pattern, Curve Driven Pattern, Sketch Driven 

Pattern, Table Driven Pattern, Fill Pattern and Variable Pattern, available in the Linear 

Pattern flyout, as shown. You can save much time using this tool as you can create multiple 

copies of a feature. Also, if you make changes to original feature, the pattern/child features 

will be updated automatically. 

q. Linear Pattern 
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  The Linear Pattern tool is used to create multiple instances of selected feature or features 

with uniform space along a single or two linear paths. 

     Click on the Linear Pattern tool from the Features Command Manager to activate it and 

display the Linear Pattern Property Manager, as shown. > Click on the edges of the model 

to define both as Direction1 and Direction2 to pattern in both directions, as shown. 

 
Click on the feature to be patterned and display preview of pattern feature, as shown. > 

Now enter or adjust the required spacing value and number of instances in their respective 

spinners available in the Direction1 and Direction2 callout attached with selected edges, as 

shown. Alternatively, you can enter these values in their respective edit boxes, available in 

the Linear Pattern Property Manager, as shown above. > Click on the OK button of the 

Property Manager to display the Pattern Feature, as shown. 

 

r. Circular Pattern 

This tool is used to create multiple instances of selected feature or features with uniform 

space along an axis. 

Select the Circular Pattern option from the Linear Pattern flyout of the Features Command 

Manager to activate it and display the CirPattern Property Manager, as shown. > Click on 

the feature to be patterned, as shown. > Click in the Pattern Axis box under Direction 1 box 

of the Property Manager, as shown > Next, click on the circular face of the model to define 

it as Pattern Axis and display the preview of circular pattern feature along it, as shown > 

Now enter or adjust the required angular spacing value and number of instances in their 

respective spinners available in the Direction1 callout attached with selected face, as 

shown. Alternatively, you can enter these values in their respective edit boxes, available in 

the Cir Pattern Property Manager, as shown. > Click on the OK button of the Property 

Manager to display the Pattern Feature, as shown. 
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2.4 Smart Dimension 

In SolidWorks there are different types of tools/options that are used for applying 

dimensions to the sketch. These options are available in the Smart Dimension flyout. 

 
a. Smart Dimension 

 The Smart Dimension tool is used to generate the dimensions with respect to the entity 

selected like horizontal dimensions, vertical dimensions for line entities and radius, dimeter 

for circle/arc entities etc. Click on the Smart Dimension button from the Sketch Command 

Manager to activate it. > Click on the required entity to generate/display its dimension, as 

shown. > Move the cursor up to some distance and press the LMB (Left Mouse Button) to 

place the dimension, as shown. 

 
The dimension of the selected entities gets displayed in the Modify dialog box. You can 

enter the required dimension value in it, as shown. > Click on the button to display the 

dimension generated and exit the Modify dialog box, as shown. You can also edit the 

dimensions at any time by using the Modify tool, discussed further in this book. > Press the 

ESC button to deactivate the Smart Dimension button. 
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2.5 Feature Tool 

In Solid works, "Feature Tool" encompasses a broad category of functionalities within the 

software used to create and modify the geometry of 3D models. These tools essentially act as 

building blocks, allowing you to progressively add or remove material to shape your design. 

a.  Extruded boss 

The Extrude is the process of creating a two-dimensional profile and converting it into three 

dimensional, perpendicular to the sketching plane and by giving it the required depth value. 

To create a cylinder, draw a circle and after selecting the Extrude Boss/Base tool, select it. 

The Extrude Boss/Base tool allows you to create a solid or surface, and add material. After 

selecting this tool from the Features Command Manager; the Boss-Extrude Property 

Manager will be displayed as shown. 

 
Some of the important options used in the Boss-Extrude PropertyManager are discussed 

next. 

▪ From: The options in the Start Condition drop down under from rollout are used to 

set the starting condition for the extrude feature. 

 
▪ Sketch Plane: This option is selected to start the extrude from the plane on which 

the sketch is located, as shown. It is selected by default. 

 
▪ Surface/Face/Plane: This option is selected to start the extrude from the selected 

face/surface/plane, as shown. 
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▪ Vertex: This option is selected to start the extrude from the selected vertex, as 

shown. 

 
▪ Offset: This option is selected to start the extrude at offset distance from the current 

sketching plane, as shown. By entering the required offset distance value in the 

Enter Offset Value spinner, as shown. 

 
▪ Direction 1: The options in this rollout are used to set the end condition for 

extruding the sketch in one direction from the sketching plane. The options in this 

rollout are discussed next. 

▪ End Condition: This options in this drop-down list are used to specify depth or 

depth values while using the Extrude tool to extrude the sketch. These options are 

discussed next. 

 
You can click on the Reverse Direction button to extrude the sketch in opposite direction. 

▪ Blind: This option is selected by default and is used to extrude a sketch from the 

sketching plane by the specified depth value, entered in the Depth spinner, as 

shown. 
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▪ Through All: This option is selected to extrude the sketch through all surfaces, as 

shown. 

 
▪ Up To Next: This option is selected to extrude a section up to the next surface, as 

shown. You cannot use a datum plane as a terminating surface. 

 
▪ Up To Vertex: This option is selected to extrude a sketch up to the surface of the 

selected vertex, as shown. 

 
▪ Up To Surface: This option is selected to extrude a section to the selected surface 

or plane, as shown. 
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▪ Offset From Surface: This option is selected to extrude a section up to the 

specified offset distance from the selected surface or plane, as shown. 

 
▪ Up To Body: This option is selected to extrude a section up to the selected body, as 

shown. 

 
▪ Mid Plane: The Mid Plane option is selected to extrude the sketch symmetrically 

in both the directions of the plane or selected surface on which the sketch is drawn, 

as shown. You can also select and drag the handle to adjust the extruded sketch, as 

shown. 

 
▪ Direction of Extrusion: This is used to extrude a section along the direction vector 

like linear edges, vertices, reference points, sketch points and so on. Below is the 

figure in which the section is extruded along the line entity, selected as a direction 

vector. 
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▪ Merge result: This checkbox is selected to merge the resultant body with the 

existing body if possible. Unless the feature creates an individual sold body. 

 

▪ Draft On/Off: This button is selected to specify the draft angle to taper the resultant 

feature while extruding the sketch. This button is not selected by default. 

▪ Select the Draft On/Off button to activate Draft Angle spinner, as shown. > Enter the 

required draft angle value in the Draft Angle spinner to display preview of the extrude 

feature with taper inwards, as shown. > Select the Draft outward checkbox to taper 

the feature outwards, as shown. 

 
▪ Direction 2: This checkbox is selected to extrude the sketch in both directions or 

with different depth values from the sketching plane. Note that, this checkbox will 

not be available, if you select Mid Plane from the End Condition drop-down list of 

the Boss-Extrude Property Manager, as discussed earlier. 

▪ The Direction 2 rollout and its option get activated only after selecting Direction 2 

checkbox. The use of options in this rollout is same as of options in the Direction 1 

rollout, as discussed above. 

 

▪ Thin Feature: This checkbox is selected to activate the options used for creating thin 

features with required thickness like sheet metal components. The use of options in 

this rollout will be discussed further in this book. 

 

▪ Selected Contours: This is used to select partial region/sketch to create extrude 

features along it. 

▪ Activate the Extruded Boss/Base tool to display the Boss-Extrude Property Manager. 

> Now click on the partial region of sketch to extrude it and display the preview of 

extruded feature, as shown. Also, the selected sketch gets visible in the Selected 

Contours box of the Property Manager, as shown. > Next, you can enter the required 

depth value in the Depth spinner or select and drag the extruded handle, as shown. 
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b. Extrude cut 

The Extruded cut is the process of removing the material from the previously created 

features. By creating a two-dimensional profile and then extruded perpendicular to the 

sketching plane to remove material from the previously created features by selecting the 

required options. After selecting Extruded Cut tool from the Features Command Manager; 

the Cut-Extrude Property Manager will get displayed as shown. 

The use of options in Cut-Extrude Property Manager is same as discussed earlier in Boss-

Extrude Property Manager. The only difference is these options are used to remove 

material. Some of the important options used in the Cut-Extrude Property Manager are 

discussed next. 

▪ Blind: This option is selected by default and is used to extrude the sketch to the 

specified depth value, entered in the Depth spinner to cut the solid feature, as shown. 

 
Through All, Through All – Both, Up To Next, Up To Vertex, Up To Surface, Offset 

From Surface, Up To Body, Mid Plane, Direction of Extrusion similar to Extruded 

Boss/Base, But it’s different to solid and Cut. 

▪ Draft On/Off: This button is selected to specify the draft angle to taper the 

resultant feature while extruding the sketch. By default, this button is not selected. 

Select the Draft On/Off button to activate Draft Angle spinner and Draft outward 

checkbox, as shown. > Enter the required draft angle value in the Draft Angle 

spinner to create cut feature with taper inwards, as shown. > Similarly, you can 

create cut feature with taper outwards, by selecting the Draft outward check box, as 

shown. 

▪ Direction 2: This checkbox is selected to extrude the sketch in both directions from 

the sketching plane. The use of options in this rollout is same like options in the 

Direction 1 rollout, as discussed above. Note that, this checkbox will not be 

available, if you select Mid Plane from the End Condition drop-down list of the Cut 
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Extrude Property Manager, as discussed earlier. Below you can see Cut feature with 

specified Draft Angle values extruded in both directions after selecting Direction 2 

check box. 

 

 

 

 

 

c. Draft 

Draft Feature 

The Draft tool is used to add taper to the selected faces of the model. This tool is mostly 

used to the model for molding and casting. After applying taper on faces, the model can be 

easily removed from the mold or die. To create a draft feature, follow the steps: 

Select the Draft tool from the Features Command Manager to display Draft Expert Property 

Manager, as shown. > Next click on the Manual button of the Property Manager to display 

the Draft Property Manager, as shown. 

   
Select the Neutral radio button under Types of Draft rollout of the Property Manager, if it 

not selected by default. > Now first select the face to define it as the Neutral plane with 

respect to which you can taper other faces, as shown. The selected faces get visible in the 

respective boxes of the Property Manager and you can edit and change them any time, as 

shown. 
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Now enter the required draft angle value in the Draft Angle spinner of the Property Manager. 

Also, you can select the Reverse Direction button to flip its direction. > Now click on the OK 

button to exit the Property Manager and display the draft feature, as shown. 
d. Revolve boss and cut 

Revolved Boss/Base Tool 

This revolve feature is the process of revolving a 2D sketch about a centerline at a specified 

angle by using the Revolved Boss/Base tool. It can be used to add the material. 

Draw the sketch with a centerline, as shown. > Click on the Revolved Boss/Base tool from 

the Feature Command Manager and select the axis to display Revolve Property Manager, 

as shown. > Also, the sketch will be revolved with 360 degrees angle and the preview of the 

revolve feature get visible, as shown. 

 
The Axis of Revolution option in the Revolve Property Manager is used to specify the axis, 

about which the sketch revolves. The Angle spinner is used to specify the angle of rotation. By 

default, the sketch will be revolved with 360 degrees. You can enter the required angle value 

in it. The use of other options in this Property Manager is same as that of the options in the 

Boss-Extrude Property Manager, previously discussed. 

 
Now, click on the OK button to exit the tool and display the revolve model, as shown. > 

Similarly, you can create revolve model with 270 degrees, as shown. Also, to reverse the 

direction of revolution, you can use the Reverse Direction button under Direction 1 rollout 

of the Property Manager, if required. > Next, you can use the MMB (middle mouse button) 

to rotate the model to change the orientation of the model, if required. 
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e. Revolved Cut Tool 

This tool is used to remove the material from the existing feature, by revolving a sketch 

around an axis, as discussed earlier in Revolved boss/base tool. 

To use the Revolved Cut tool in removing material from existing feature, follow the 

steps: 

Draw the sketch on an existing feature created along with the centerline, as shown. > 

Click on the Revolved Cut tool from the Feature Command Manager and select the axis 

to display preview of revolved feature along with Revolve Property Manager, as shown. 

           
You can enter 180 in the Direction 1 Angle spinner to remove material with revolving sketch 

at 180 degrees, as shown. > Click on the Reverse Direction button to reverse direction of 

revolve feature, if required. > Now, click on the OK button from the PropertyManager to 

exit the tool and display the 3D model with revolve cut feature, as shown. 

   
f. Lofted boss and cut 

Lofted Bose/Base Tool 

This tool is used to create a solid model by connecting two or more sketches created on 

different planes, as shown. The steps to create a lofted feature are explained below: 

Draw three different sketches on 3 different planes, as shown. > Select the Lofted Boss/Base 

tool from the Features Command Manager to display Loft Property Manager, as shown. 

 
Click on the sketch entities or constraints of all sketches one by one to display the lofted 

feature with green colored handles of the connector, as shown. Note that the lofted feature 

will be created according to the order in which you select the sketch entities or constraints. 

> You can change the shape of lofted feature by dragging the green colored handles of the 
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connector attached with it, as shown. > Now click on the OK button from the Property 

Manager to exit it and display the lofted feature created. 

 

   

The use of Lofted Cut tool 

This is almost same as that of the Lofted Boss/Base tool. The only difference is this tool is 

used to remove material from a solid model. The steps to create a lofted cut feature are: 

Create sketch on two planes or two faces of any solid model, as shown. > Next click on the 

Lofted Cut tool to activate it and display the Cut-Loft Property Manager and preview of lofted 

feature, as shown. 

 
Next click on the OK button of the Property Manager to exit it and display the Lofted Cut 

feature, as shown. 

 
g. Swept boss and cut 

Swept Boss/Base Tool 

The Swept Boss/Base tool is used to create a sweep based features by sweeping/extruding 

an open or close profile, along a path. This tool allows you to create a solid, & surface 

feature for the same. 

Draw the sketch on the Top plane, as shown. > Next create a plane, perpendicular at one end 

of the recently drawn sketch and draw another sketch over it, as shown. Now you can use 

these two sketches as profile and path for creating the sweep feature, as shown. 
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Select the Swept Boss/Base tool from the Features Command Manager to display Sweep 

Property Manager, as shown. > Select the profile sketch first and then select the path sketch to 

display preview of sweep feature, as shown. 

 
Click on the OK button of the Property Manager to display the sweep feature created, as 

shown. 

h. The Swept Cut tool 

The Swept Cut tool can be used for removing material by sweeping/extruding a 

section/profile, along a path. The procedure of using this tool is same as that of Swept 

Boss/Base tool, as discussed previously. The only difference is that this tool cab be used 

only after creating a solid model. > Draw two sketches on two different surfaces/planes of 

the model as profile and path, as shown. 

 
Click on the Swept Cut button from the Features Command Manager to display Cut-

Sweep Property Manager, as shown. > The Sketch Profile radio button in the Property 

Manager is selected by default, as shown. > Select the profile sketch first and then 

select the path sketch to display preview of sweep feature, as shown. 

 
i. Boundary bosses and cuts 
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Boundary Bose/Base Tool: This tool is used to create feature by adding material in two 

directions. This tool is mostly used in creating complex or curved bodies. You need to create 

two profiles between which you can add material. You can specify sketch curves, faces, edges, 

or other sketch entities to control the shape of a boundary feature. Draw the sketch on Top Plane, 

as shown. > Next create another sketch of two entities on Front Plane, as shown. 

   
Now select the Boundary Boss/Base tool from Features Command Manager to activate it and 

display the Boundary Property Manager, as shown. > Click on the profile sketch, as shown. 

 
Click in the Curves selection box and then click on the path sketch, as shown. > Click on the 

OK button of the message box to select it and display preview of boundary boss/base feature, 

as shown. 

 
Similarly select another sketch entity, as shown. 

 



 

      Page | 62  
 
 

Next, you can select the required option for all drop-down attached with control points, as 

shown. > Click on the OK button of the Property Manager to exit it and display boundary 

boss/base feature, as shown. 

   
 

 

Boundary Cut Tool 

This tool is used in removing material between two profiles in two directions. This tool is 

also mostly used in creating complex or curved bodies. You need to create two profiles 

between which you can remove material. You can specify sketch curves, faces, edges, or 

other sketch entities to control the shape of a boundary feature. 

Draw the sketch on different faces of model, as shown. > Now select the Boundary Cut 

tool from Features Command Manager to activate it and display the Boundary-Cut 

Property Manager, as shown. > Select the two sketches one by one to display preview of 

Boundary Cut feature, as shown. 

j. Pattern 

In SolidWorks, there are various Pattern tools, used to create replica of a feature using 

different options - Linear Pattern, Circular Pattern, Curve Driven Pattern, Sketch Driven 

Pattern, Table Driven Pattern, Fill Pattern and Variable Pattern, available in the Linear 

Pattern flyout, as shown. You can save much time using this tool as you can create multiple 

copies of a feature. Also, if you make changes to original feature, the pattern/child features 

will be updated automatically. 

 
The Options available in the Linear Pattern flyout are discussed next. 

k. Linear pattern 

The Linear Pattern tool is used to create multiple instances of selected feature or features 

with uniform space along a single or two linear paths. 

Click on the Linear Pattern tool from the Features Command Manager to activate it and 

display the Linear Pattern Property Manager, as shown. > Click on the edges of the model 

to define both as Direction1 and Direction2 to pattern in both directions, as shown. 



 

      Page | 63  
 
 

 
Click on the feature to be patterned and display preview of pattern feature, as shown. > Now 

enter or adjust the required spacing value and number of instances in their respective spinners 

available in the Direction1 and Direction2 callout attached with selected edges, as shown. 

Alternatively, you can enter these values in their respective edit boxes, available in the Linear 

Pattern Property Manager, as shown above. > Click on the OK button of the Property Manager 

to display the Pattern Feature, as shown. 

 

 
l. Circular pattern 

This tool is used to create multiple instances of selected feature or features with uniform 

space along an axis. 

Select the Circular Pattern option from the Linear Pattern flyout of the Features Command 

Manager to activate it and display the Cir Pattern Property Manager, as shown. > Click on 

the feature to be patterned, as shown. > Click in the Pattern Axis box under Direction 1 box 

of the Property Manager, as shown. > Next, click on the circular face of the model to define 

it as Pattern Axis and display the preview of circular pattern feature along it, as shown. 

>Now enter or adjust the required angular spacing value and number of instances in their 

respective spinners available in the Direction1 callout attached with selected face, as 

shown. Alternatively, you can enter these values in their respective edit boxes, available in 

the Cir Pattern Property Manager, as shown. > Click on the OK button of the Property 

Manager to display the Pattern Feature, as shown. 
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m. Shell and Rib 

Shell tool: The Shell tool is used to apply to solid model to make it hollow. Thus, this is 

very time saving technique during creating thin walls solid models like tanks, containers, 

and bottles. To create a draft feature, follow the steps: 

Select the Shell tool from the Features Command Manager to display Shell Property 

Manager. > Click on the face/faces to remove, as shown. > Enter the required thickness in 

the Thickness spinner of the Property Manager, as shown. > Also, select the Show preview 

check box to display the preview of the model, as shown. > Now click on the OK button 

to exit the Property Manager and display the model with shell feature, as shown. 
 

 

Rib 

Ribs are the features that are used to strengthen the solid parts. This feature is almost similar 

to the extruded feature, the only difference is that it requires an open sketch. After selecting 

the open sketch and applying the required thickness, it automatically creates the rib feature. 

It also adds the material on both sides with symmetric thickness. 

Select the Rib tool from the Features Command Manager to display Rib Property Manager, 

as shown. > Select the required plane on which you want to create rib feature and enter in the 

sketching environment, as shown. 
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Press the CTRL + 8 key to adjust the sketching plane, parallel to the screen and draw the 

sketch, as shown. > Click on the Exit Sketch button to exit the sketching environment and 

display the preview of rib feature along with Rib1 Property Manager, as shown. 

 
Select the required Thickness button to define the side of the sketch to add material and 

thickness of the rib feature. > Also, you can enter the required Rib Thickness and Draft Angel 

values in their respective spinners. > The Extrusion direction buttons are selected to create the 

rib extrusion, parallel to the sketch or normal to the sketch. > Next click on the OK button of 

the Property Manager to display the Rib feature created, as shown. 

 

Mirror 

The Mirror tool is used to copy/mirror the selected feature and body about a selected mirror 

plane or planar face. This tool is useful while designing a symmetric part by saving your time. 

By using this tool, you can copy individual features of the entire body. For creating a mirror 

feature in 3D geometry, you need a place or planar face to use it as the mirroring element. You 

can use default planes, model faces or sometime you need to create a datum/reference plane. 

 
Create reference planes across the model to be used later as mirroring planes, as shown > 

Select the Mirror tool from the Features Command Manager to display Mirror Property 

Manager, as shown. > Select the mirroring place with respect to which you want to create 

mirror feature, as shown. > Next, select the feature to be mirrored and to display the preview 

of mirror feature, as shown. > Now click on the OK button to exit the Property Manager and 

display the model with mirror feature, as shown. 
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n. Hole wizard 

This tool is used to add standard holes like counterbore, countersink, tapped, drilled, and 

pipe tap holes. In SolidWorks there are various types of standard holes/slots grouped in 

the library. These options can be used for creating different types of holes. You can also 

create customized hole using this tool. 

Activate the Hole Wizard tool from the Feature Command Manager to display Hole 

Specification Property Manager, as shown. 

 
o. Rap 

The Wrap tool is used to emboss, deboss, or scribe a sketch or text on the selected planar 

or curved faces. The plane and selected faces should be parallel or tangent to each other, as 

shown. To create a draft feature, follow the steps: 

Draw the sketch on plane, parallel/tangent to the face to be selected, as shown. > Select the 

sketch and then select the Wrap tool from the Features Command Manager to display Wrap 

Property Manager, as shown. 

 
Click on the required button from Wrap Type and Wrap Method rollout of the Wrap 

Property Manager, as shown above. > Click in the Source Sketch area under the Wrap 

Parameters rollout of the Property Manager and select the sketch. > Click in the Face for 

Wrap Sketch area and click on the face to display preview of wrap feature over it, as shown. 

> Next, enter or adjust the required thickness value in the Thickness spinner, as shown. > 

Now click on the OK button to exit the Property Manager and display the model with wrap 

feature, as shown. 
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2.6 Assembly Tool 

After creating individual components, you can bring them together into an assembly. By 

doing so, it is possible to identify incorrect design problems that may not have been 

noticeable at the part level. In this chapter, you will learn how to bring components into the 

Assembly environment and position them. 

a Edit component 

▪ Starting an Assembly 

To begin an assembly file, click on the New button from the Quick Access Toolbar to 

display New SOLIDWORKS Document dialog box. From the dialog box, select the 

Assembly button and click on the OK button to entering in the assembly environment, as 

shown. The Assembly environment with Assembly tab opened and Begin Assembly 

Property Manager get displayed, as shown below. 

 

▪ Assembly Environment 

The Assembly environment has tools to combine individual parts in an assembly. There are 

two ways to create an assembly. The first way is to create individual parts in part environment 

and then assemble them in the Assembly environment, known as Bottom-up assembly 

design. The second way is to start an assembly file and create individual parts in it, known 

as Top-down assembly design. 
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b Insert component 

There are two different methods to insert an existing part into an assembly. The first one is to 

insert using the Insert Components button. The second way is to drag it directly from Windows 

Explorer. In the second method, there is no need to open the components in Open window. 

You can simply drag- and-drop them into the assembly. 

Click on the Insert Components button from the Assemble Command Manager to display 

Open window, as shown. > Browse to the required folder and select the required part file, as 

shown. > Next click on the Open button to display it in the assembly environment, as shown. 

Alternatively, you can double click on the required file to import it.  

 
 

After importing the first component, it will get fixed at the origin automatically, as shown. 

And then after inserting other components, you can assemble them with respect to it. 

c Met 

After activating the Mate tool and selecting the entities, the system automatically applies the 

respective mate/constraint with respect to the selected entities. After selecting two flat 

surfaces; Coincident mate gets applied and after selecting two circles; Concentric mate get 

applied and so on. 

After inserting any component, select the Mate tool to activate it and display the Mate 

Property Manager, as shown. > Click on the two flat surface one-by-one to display preview 

of automatically applied Coincident mate between both, as shown. > Next to apply any 

change or apply any other mate, you can click on the buttons available in the Mate pop-up 

toolbar displayed, as shown. The use of buttons in the Mate pop-up toolbar are displayed 

further in this chapter. > Now click on the Add/Finish Mate button to apply mate and display 

components with applied mate, as shown. 
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Click on the OK button of the Mate Property Manager to exit it. 

Similarly, after selecting circular surfaces of two components, Concentric constrains will 

be applied automatically, as shown. 

 
Note that, after activating the Mate tool and selecting two surfaces of two components, the 

Mate pop-up toolbar will also get display along with automatically applied respective mate, 

as shown above. And if required you can also select another mate from it. The use of other 

buttons in this pop-up. 

toolbar are: 

Flip Mate Alignment – This button is selected to flip the direction of applied mate. 

Undo – This button is selected to go back after applying any mate. 

Add/Finish Mate - After applying mates, this button is selected to exit pop-up toolbar and 

display components with applied mates. 

▪ Coincident Mate: The use of Coincident constraint is same as discussed above. 

▪ Parallel Mate: The Parallel mate makes an axis, face or edge of one part parallel to 

that of another part. > Click on the Parallel button from the Mate Property Manager, 

as shown above. > Click on the two flat surfaces one by one to display preview of 

Parallel mate between them, as shown. > Next click on the Add/Finish Mate button 

to apply mate and display components with applied mate, as shown. 

 
▪ Perpendicular Mate: The Perpendicular mate is used to make two selected 

surfaces or two axes perpendicular to each other. 
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▪ Tangent Mate: The Tangent mate is used to make the selected circular face tangent 

to the other selected face or plane. 

 
▪ Concentric Mate: The Concentric mate is used to make the axes of two cylindrical 

faces coincide/concentric with each other. 

 
▪ Lock two components together: The Lock mate is selected to lock two components 

together and thus maintains position and orientation with each other. Note that, after 

applying the Lock mate between components, if you move any component then other 

component/components also start moving with it. 

▪ Distance Mate: The Distance mate is selected to place the selected faces at the 

specified distance between them. 

Click on the Distance button from the Mate Property Manager, as shown above. > 

Click on two surfaces to place distance between them. > Next enter or adjust the 

required distance value in the Distance spinner of the Mate pop-up toolbar, as shown. 

> Next click on the Add/Finish Mate button to place the selected items at the defined 

distance value, as shown. 

 
▪ Angle Mate: The Angle button is used to position the selected faces at a specified 

angle. Click on the Angle button from the Mate Property Manager, as shown above. 

> Click on two flat surfaces to position them at an angle with each other, as shown. 

> Next enter or adjust the required angle value in the Angle spinner of the Mate pop-

up toolbar, as shown. > Next click on the Add/Finish Mate button to place the selected 

items at the defined angle value, as shown. 
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▪ Fix: The Fix option from the shortcut menu is used to fix the component inserted in 

the assembly environment, as discussed earlier. After adding fixing the component, 

its degrees of freedom in the drawing area get removed and you cannot move or rotate 

it. 

Right click over the component to be fixed in the assembly environment area to 

display the shortcut menu, as shown. > Next select the Fix option, the component 

gets fixed and you will not be able to move or rotate it. > Also, if you need to move 

or rotate any fixed component then you need to remove Fix over it. > Right click 

over the fixed component and select the Float option from the shortcut menu, as 

shown. > Now you can again move and rotate the component. 

 

d Component Preview window 

The Component Preview Window in SolidWorks is a helpful tool that allows you to focus 

on a specific component within an assembly while keeping the context of the entire 

assembly visible. 

 

e Linear component pattern 

Linear Component Pattern tool from the Assembly Command Manager to activate it and 

display the Linear Pattern Property Manager, as shown. 

Click on two edges to define as Direction 1 and Direction 2 and click on the Bolt component 

to Pattern, as shown. > Next, enter the required entries in the Property Manager to display 

preview of Pattern feature, as shown. 
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Next click on OK button of Linear Pattern Property Manager to exit it and display mirrored 

components, as shown. 

 

f Smart fasteners 

Smart Fasteners in SolidWorks are a feature within the SolidWorks Toolbox that automates 

the population of fasteners within your assemblies. They streamline the process of adding 

nuts, bolts, and other hardware components, saving you time and effort. 

g Move component 

Select the Move Component command under the Assembly tab, as highlighted in the 

following screenshot: 

On the Property Manager, select the Collision Detection option. Also, make sure to check the 

Stop at collision and Dragged part only options and the Highlight faces and Sound advanced 

option. 

      
Once we have the parts at the colliding position, we can use the Smart Dimension command 

to get the exact collision angle or distance measurements. For instance, in this exercise, we 

can measure the collision angle with the following steps: 
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Drag the arm clockwise until it collides with the major joint, as shown in Figure > Use the 

Smart Dimension command in the Layout tab to measure the angle between the arm and the 

major joint, as in Figure. 

 
This way, we will be able to identify the collision angle between the arm and the major joint 

as 90 degrees, as highlighted in the following screenshot. Those numerical measurements can 

then help us to make different design decisions. 
2.7 Standard file format 

After creating any model, click on the Save button to display the Save As dialog box, as 

shown. Browse to the desired folder and enter the desired name in the File name edit box, if 

required.  Next, click on the Save button to save the file in the selected folder, as shown. 

 
Note: When you click on the Save button, the Save As dialog box with the previously selected 

folder get displayed. If you click on the Save button the object gets saved in that folder. You 

can browse to any other folder/location and save the object there, if required. 

SolidWorks utilizes two main categories of file formats: native and neutral formats. 

▪ Native SolidWorks Formats: 

▪ SLDPRT (.sldprt): This format is used for individual parts created within SolidWorks. It 

stores all the geometric data and feature information specific to the software. 

▪ SLDASM (.sldasm): This format is employed for assemblies, which combine multiple 

SLDPRT files to represent a product or machine. It contains the references and positional 

relationships between parts. 

▪ SLDDRW (.slddrw): This format is used for creating 2D engineering drawings from 3D 

models (usually SLDPRTs). It includes dimensions, annotations, and views of the parts. 

▪ SLDDRT (.slddrt): This format represents drawing sheet templates that define the layout 

and formatting for SLDDRW files.These native formats offer the advantage of preserving 

all the design intent and information within SolidWorks, but they are not universally 

compatible with other CAD software. 

▪ Neutral File Formats: 
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SolidWorks also supports importing and exporting files in various neutral formats, 

enabling data exchange with other CAD programs. Some commonly used neutral formats 

include: 

▪ IGES (.igs, .iges): This is a widely recognized format for exchanging 2D and 3D 

geometric data between different CAD systems. 

▪ STEP (.stp): Another ISO standard format for exchanging product data, STEP offers a 

more comprehensive approach compared to IGES. 

▪ STL (.stl): Primarily used for 3D printing, this format represents a surface mesh of the 

3D model, suitable for additive manufacturing processes. 

▪ Choosing the appropriate file format depends on your specific needs. If collaborating 

solely within the SolidWorks environment, native formats are ideal. For sharing data with 

users of other CAD software, neutral formats like IGES or STEP become essential. 

2.8 Drawing interpretation 

Drawing interpretation, also known as Geometric Dimensioning and Tolerancing (GD&T), 

is the process of extracting information and understanding the intent behind a technical 

drawing. These drawings are the blueprint for manufacturing a product, conveying precise 

instructions on its dimensions, tolerances, and specifications. 
a. Standard drawing scales, symbols, and abbreviations 

Engineering drawings rely on a universal language of symbols, abbreviations, and scales to 

ensure clear and consistent communication between designers, engineers, and 

manufacturers. Here's a detailed breakdown of these standards: 

b. Orthographic projection (1st and 3rd angle) 

you can effectively utilize SolidWorks to create multi-view drawings based on either 1st or 

3rd angle orthographic projection, ensuring clear communication in the design and 

manufacturing process. 

 
c. Perspective 

perspective mode allows you to view your 3D model in a way that simulates how we see 

objects in the real world. Parallel lines in the model converge towards a vanishing point in the 

distance, creating a more natural depth perception compared to the standard orthographic 

views. 
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Section view 

This tool is used to create section view of the drawing view by cutting it with the section 

line or section plane. 

Click on the Section View button from the View Layout Command Manager to display the 

Section View Assist PropertyManger, as shown.  Click on the required button under 

Cutting Line rollout of the Property Manager, as shown.  Next click to define the position 

of the cutting line, as shown.  Now, click on the OK button of the toolbar displayed, as 

shown.  Move the cursor up to some distance and click to place the generated section 

view, as shown.  Click on the Close dialog button of the Property Manager to exit it. 

 
In part design, the option will see in view setting > section view. 

 
d. Dimensioning 

SolidWorks offers various dimensioning tools to precisely define the sizes and geometric 

relationships between elements in your 2D sketches and 3D models. Here is a breakdown 

of the key concepts and methods for dimensioning in SolidWorks: 

Types of Dimensions: 

▪ Linear Dimensions: Specify the distance between two points. 

▪ Angular Dimensions: Define the angle between two lines. 

▪ Radius and Diameter Dimensions: Indicate the radius or diameter of circles and 

arcs. 

▪ Geometric Dimensions and Tolerances (GD&T): A more advanced set of 

dimensions used to define form tolerances, location tolerances, and other 

geometric characteristics. 
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e. Measurement tolerance 

measurement tolerance refers to the permissible variation allowed for a specific 

dimension. It essentially defines the acceptable range within which a dimension can 

deviate from its nominal value and still be considered functional for the part. 

Importance of Tolerance: 

▪ Ensures Functionality: 

Tolerances account for inevitable manufacturing variations and ensure parts fit 

together correctly and function as intended.  

▪ Cost Optimization: Tighter tolerances improve precision but can increase 

manufacturing cost. Specifying appropriate tolerances balances functionality with 

cost-effectiveness.  

▪ Clear Communication: Tolerance values clearly communicate the designer's 

expectations regarding the acceptable range of variation for each dimension. 

Surface condition (surface finish/texture) 

Surface condition, also referred to as surface finish or texture, describes the microscopic 

irregularities on the surface of a material. It's a crucial aspect of design and manufacturing, 

impacting factors like friction, wear, contact mechanics, and aesthetics. 

f. Limit and fit 

Limit and fit are closely related concepts in SolidWorks design, used to define the 

intentional variations in the size and shape of mating parts to achieve a desired assembly 

outcome. 
Applying Limits and Fits in SolidWorks: 

• Hole Wizard: When creating holes in parts, the Hole Wizard allows you to specify 

the hole size and choose a fit type (clearance, interference, etc.) from a predefined 

list. SolidWorks automatically calculates the appropriate hole diameter and shaft 

diameter tolerances based on the selected fit. 

• Dimensioning and Tolerances: You can directly apply tolerances to dimensions of 

features like shafts and holes to control their size variations. SolidWorks offers 

various tolerance types (linear, geometric, etc.) suitable for defining fits. 

g. Clearance 

clearance refers to the amount of space intentionally left between two mating parts, 

components, or features. This space is crucial for ensuring proper assembly, functionality, 

and performance of the overall design.   
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Self-Check Sheet 2: Create CAD Model 

 

1. Which method would you use to create a new template? 

Answer: 

 

2. Explain what is SolidWorks?  

Answer: 

 

3. List out the major difference between the AutoCAD and SolidWorks?  

Answer: 

 

4. Explain how you can insert a reference image in SolidWorks?  

Answer: 

 

5. List out the major or basic components of Feature Manager design tree?  

Answer: 

 

6. Explain how you can engrave text to part in SolidWorks?  

Answer: 

 

7. Define what Groups is and Cut lists in SolidWorks?  

Answer: 

 

8. Mention what does the weldments-pierce points indicates in SolidWorks?  

Answer:   
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Answer Sheet 2: Create CAD Model 

 

1. Which method would you use to create a new template? 

Answer: There are three main steps applicants should outline when explaining how to create 

a new template in SolidWorks: 

▪ The first step is to open the SW module required (which may be drawing, part, or 

assembly) 

▪ The second step is to make the setting modifications in SolidWorks 

▪ The final step is to save the file as a part, assembly, or drawing template (depending 

on the type of template required) 

2. Explain what is SolidWorks?  

Answer: SolidWorks is a computer aided design tool or software that runs on Microsoft 

Windows.  

3. List out the major difference between the AutoCAD and SolidWorks?  

Answer: The significant difference between the SolidWorks and AutoCAD is that AutoCAD 

was designed and developed as a 2D package and later evolved into a 3D package while 

SolidWorks is developed as 3D  

4. Explain how you can insert a reference image in SolidWorks?  

Answer To add a reference image in SolidWorks follow these steps On the front plane open a 

new sketch Draw some reference geometry to help in sizing and positioning of the image Now 

to insert an image, go to -> Tools -> Sketch Picture Choose the image you want to insert and 

tap on “Open” Once the image gets inserted use the command box on the left of the panel, to 

adjust the size of the image.  

5. List out the major or basic components of Feature Manager design tree?  

Answer: The basic components of Feature Manager design tree includes Part Subassembly 

Flexible Subassembly  

6. Explain how you can engrave text to part in SolidWorks?  

Answer: To engrave text in SolidWorks you have to Once you have created the parts or your 

design ready in SolidWorks you have to go to main menu bar  

Under main menu bar -> Select tools  

Tools -> click on Sketch Entities  

Sketch Entities -> Text  

Input the text into the text box  

To change the font - uncheck the use document font and set the font type and size  

To engrave the text click Features -> tap on Extruded Cut -> now under direction 1 Blind, set 

the D1, and then click Isometric from the lower left view menu  

7. Define what Groups is and Cut lists in SolidWorks?  

Answer: Groups: A group is a collection of the related segment in a structural member Cut 

lists: Under Feature Manager design tree, cut list is an item that groups the same entities of a 

part together. It is available in parts that have sheet metal features or weldment.  

8. Mention what does the weldments-pierce points indicates in SolidWorks?  

Answer: In SolidWorks, the pierce point determines the location of the profile, related to the 

sketch segment used to form the structural member. 8) From where you can access 

SolidWorks API? SolidWorks API is a com programming interface to the SolidWorks 

software. To access the API, you to go to Help -> API Help Topics   
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Task  Sheet 2-1: Set The Drawing Interface for 2D Drawing 

 

Procedure: 

1. Wear appropriate PPE for the job 

2. Read the Job sheet and Specification sheet provided 

3. Collect all needed materials, supplies, and equipment 

4. Prepare the tools, equipment, and materials for use 

5. Follow hygiene and safety requirements during the demonstration processes 

6. Apply the relevant commands such as; Line, Rectangle, Polyline, Circle, Trim entities, 

copy entities, Mirror entities, rotate entities, offset entities, Move entities, etc. 

7. Clean workplace. 

8. Store tools and equipment in a safe place. 
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Specification Sheet 2-1: Set The Drawing Interface for 2D Drawing. 
 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

Workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Job Sheet 2-2: Use Smart Dimensions 

 

Procedure: 

1. Wear appropriate PPE for the job 

2. Read the Job sheet and Specification sheet provided 

3. Collect all needed materials, supplies, and equipment 

4. Prepare the tools, equipment, and materials for use 

5. Follow hygiene and safety requirements during the demonstration processes 

6. Apply the relevant commands such as Sketch: Points, Line, Circle, Arcs, Rectangle, Splines, 

Ellipse, Polygon, Slot, Chamfer, and fillet. 

7. Apply the relevant commands such as Edit: Trim, Extend, Mirror, Offset, Copy, Move, 

Delete, Scaling. 

8. Apply the relevant commands such as Relations: Parallel, Horizontal, Vertical, Coincident, 

Collinear, Tangent, Fix. 

9. Apply the relevant commands such as Others: Pattern tool, Smart Dimension 

10. Clean workplace. 

11. Store tools and equipment in a safe place. 
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Specification Sheet 2-2-1: Use Smart Dimensions-1 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Specification Sheet 2-2-2: Use Smart Dimensions-2 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Specification Sheet 2-2-3: Use Smart Dimensions-3 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Specification Sheet 2-2-4: Use Smart Dimensions-4 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Specification Sheet 2-2-5: Use Smart Dimensions-5 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Specification Sheet 2-2-6: Use Smart Dimensions-6 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Specification Sheet 2-2-7: Use Smart Dimensions-7 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Job Sheet 2-3-1: Use The Features Tool 

 

Procedure: 

1. Wear appropriate PPE for the job 

2. Read the Job sheet and Specification sheet provided 

3. Collect all needed materials, supplies, and equipment 

4. Prepare the tools, equipment, and materials for use 

5. Follow hygiene and safety requirements during the demonstration processes 

6. Apply the relevant commands such as Sketch: Points, Line, Circle, Arcs, Rectangle, Splines, 

Ellipse, Polygon, Slot, Chamfer, and fillet. 

7. Apply the relevant commands such as Edit: Trim, Extend, Mirror, Offset, Copy, Move, 

Delete, Scaling. 

8. Apply the relevant commands such as Relations: Parallel, Horizontal, Vertical, Coincident, 

Collinear, Tangent, Fix. 

9. Apply the relevant commands such as Others: Pattern tool, Smart Dimension. 

10. Apply the relevant commands such as Feature Tools: Extruded boss, extrude cut, Draft, 

revolve boss and cut, lofted boss, and cut, swept boss, and cut, Boundary bosses and cuts, 

Linear pattern, Circular pattern, Shell and Rib, Mirror, Hole Wizard, Rap. 

11. Clean workplace. 

12. Store tools and equipment in a safe place. 
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Specification Sheet 2-3-1: Use The Features Tool-1 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Specification Sheet 2-3-2: Use The Features Tool-2 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

Workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Specification Sheet 2-3-3: Use The Features Tool-3 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

Workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Specification Sheet 2-3-4: Use the Features tool-4 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

Workstation grade 

RAM: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Specification Sheet 2-3-5: Use the Features tool-5 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Job Sheet 2-4: Assemble the Parts Using the Assembly Tool 

 

Procedure: 

1. Wear appropriate PPE for the job 

2. Read the Job sheet and Specification sheet provided 

3. Collect all needed materials, supplies, and equipment 

4. Prepare the tools, equipment, and materials for use 

5. Follow hygiene and safety requirements during the demonstration processes 

6. Apply the relevant commands such as Sketch: Points, Line, Circle, Arcs, Rectangle, Splines, 

Ellipse, Polygon, Slot, Chamfer, and fillet. 

7. Apply the relevant commands such as Edit: Trim, Extend, Mirror, Offset, Copy, Move, Delete, 

Scaling. 

8. Apply the relevant commands such as Relations: Parallel, Horizontal, Vertical, Coincident, 

Collinear, Tangent, Fix. 

9. Apply the relevant commands such as Others: Pattern tool, Smart Dimension. 

10. Apply the relevant commands such as Feature Tools: Extruded boss, Extrude cut, Draft, 

Revolve boss and cut, Lofted boss and cut, Swept boss and cut, Boundary bosses and cuts, 

Linear pattern, Circular pattern, Shell and Rib, Mirror, Hole Wizard, Rap. 

11. Apply the relevant commands such as Assembly tool: Edit component, Insert component, 

Met, Component Preview window, Linear component pattern, Smart fasteners, Move 

component. 

12. Clean workplace. 

13. Store tools and equipment in a safe place. 
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Specification Sheet 2-4: Assemble the Parts Using the Assembly Tool 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 

7 Mask No 1 

8 Anti-Static mat No 1 
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Job Sheet 2-5: Perform Model Printing 

 

Procedure: 

1. Wear appropriate PPE for the job 

2. Read the Job sheet and Specification sheet provided 

3. Collect all needed materials, supplies, and equipment 

4. Prepare the tools, equipment, and materials for use 

5. Follow hygiene and safety requirements during the demonstration processes 

6. Printing process from SolidWorks to printer. 

7. Clean workplace. 

8. Store tools and equipment in a safe place. 
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Specification Sheet 2-5: Perform Model Printing 

 
Tools, Equipment, Materials and PPE: 

SL Name Unit Quantity 

1 

Workstation computer 

Operating System: Min Win 10 (64bit) 

Processor: Intel Xeon 3.3 GHz or equivalent 

workstation grade 

Ram: min 16GB 

Graphics Card: Min 4GB Nvidia Quadro 

SSD: Min 512GB 

HDD: 1TB 

Others: Monitor, Keyboard, Mouse, etc. 

SolidWorks Installed Application 

Set 
 

1 

2 UPS No 1 

3 Plotter No 1 

4 Printer No 1 

5 USB / CD / DVD / Portable HD No 1 

6 Apron No 1 
7 Mask No 1 

8 Anti-Static mat No 1 
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Review Of Competency 
 

Below is Your Self-Assessment Rating for Module Create Model Using CAD Software 

Assessment of Performance Criteria Yes No 

▪ Workpiece orientation of the 3D model is analyzed to produce a 

CAD model 
  

▪ All general symbol, the standard of drawing is identified   

▪ Tools and equipment are selected and collected as per job 

requirements 
  

▪ Appropriate CAD software is installed as per the standard operating 

procedure 
  

▪ System parameters are selected according to the job requirement   

▪ Drawing interface is set required for 2D drawing 
  

▪ Drafting tools are used for 2D drawing 
  

▪ Smart dimension is used 
  

▪ Feature tool is used 
  

▪ Parts are assembled using assembly tools 
  

▪ Created model is saved as per standard file format 
  

▪ Model is printed as required 
  

I now feel ready to undertake my formal competency assessment. 

 

Signed: 

 

Date: 
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Development of CBLM 

 

The Competency based Learning Material (CBLM) of ‘Creating Model Using CAD Software’ 

(Occupation: CNC Maching Centre Operation with CAD CAM, Level-4) for National Skills 

Certificate is developed by NSDA with the assistance of SIMEC System Ltd., ECF Consultancy 

& SIMEC Institute of Technology JV (Joint Venture Firm) in the month of  June, 2024 under the 

contract number of package SD-9B dated 15th January 2024. 

 

SL No. Name & Address Designation Contact Number 

1 Rofiqun Nabi Writer 01841-604582 

2 Uttam Kumar Das Editor 01716-220932 

3 Engr. Md. Zuwel Parves Co-Ordinator 01737-278906 

4 Engr. Md. Nazrul Islam Reviewer 01711-273708 

 

 

  



 

      Page | 101  
 
 

 

 

Reference: 
 

1 https://www.3erp.com/blog/computer-aided-design/,  

2 https://www.solidworks.com/partner-product/solidworks-computer-aided-design. 

3 https://www.solidworks.com/product/solidworks-3d-cad, 

4 https://www.technia.com/blog/what-is-solidworks, 

5 https://help.solidworks.com/2020/english/SolidWorks/acadhelp/c_using_imported_2

d_cad_data_acadhelp.htm,  

6 https://help.solidworks.com/2022/English/SolidWorks/acadhelp/c_Using_Imported_

2D_CAD_Data_AcadHelp.htm,  

7 https://medium.com/@zacharia.zein/solidworks-2d-drawing-detailing-for-

manufacturing-process-863a4188d658,  

 

https://www.3erp.com/blog/computer-aided-design/
https://www.solidworks.com/partner-product/solidworks-computer-aided-design
https://www.solidworks.com/product/solidworks-3d-cad
https://www.technia.com/blog/what-is-solidworks
https://help.solidworks.com/2020/english/SolidWorks/acadhelp/c_using_imported_2d_cad_data_acadhelp.htm
https://help.solidworks.com/2020/english/SolidWorks/acadhelp/c_using_imported_2d_cad_data_acadhelp.htm
https://help.solidworks.com/2022/English/SolidWorks/acadhelp/c_Using_Imported_2D_CAD_Data_AcadHelp.htm
https://help.solidworks.com/2022/English/SolidWorks/acadhelp/c_Using_Imported_2D_CAD_Data_AcadHelp.htm
https://medium.com/@zacharia.zein/solidworks-2d-drawing-detailing-for-manufacturing-process-863a4188d658
https://medium.com/@zacharia.zein/solidworks-2d-drawing-detailing-for-manufacturing-process-863a4188d658

